40" Annual Multi-Campus Family Medicine Research Day

ABSTRACT AND CASE REPORT

POSTER GUIDELINES

There will be two 40-minute poster sessions (Poster Session 1 at 1:00-1:40PM; Poster Session 2 at
2:25-3:05PM). Posters will be simultaneously displayed in three break-out rooms. Please refer to your
acceptance letter to determine your poster’s assigned session and room. Upon arrival at the event,
presenters should deliver their poster to their assigned room.

Those in Poster Session 1 should set up their posters upon arrival. At the conclusion of Poster Session
1, presenters should remove their poster from display (they may store their poster in a discrete corner of the
room if they wish) before proceeding to the Dr. Beatriz Solis Hall for Lectern Session 1. This will allow event
staff to prepare the room for Poster Session 2.

Those presenting in Poster Session 2, should place their poster in a discrete corner of their assigned
room upon arrival at the event. This allows event staff to confirm that each poster has arrived and also allows
presenters to attend the rest of the event unencumbered. However, we ask that presenters please do not
place their poster for display at that time; they can set up at the end of Poster Session 1 or the beginning of
Poster Session 2. We will have event staff available to assist.

For posters that are rolled up: We ask that presenters PLEASE put their name, room, and poster session
on the outside of the roll/case so that it can be identified without needing to be unrolled.

Due to space constraints and easel size, the recommended poster size is 2 ft (H) by 3 ft (W). We
posters on poster-board/hard cardstock so they can stand upright on their own, but we will also have clips
available for those printed on paper. We do not recommend vinyl as those posters tend to be too heavy for
our clips. Presenters are welcome, but not required, to provide business cards and/or handouts to attendees.

Those presenting Research Abstracts (as opposed to Case Reports) must prepare a 60-second oral
summary (AKA “elevator pitch”) to be presented twice during their assigned Poster Session. At
approximately 10 minutes into each poster session, event staff will make an announcement and those
presenting Abstracts will take turns presenting their 60-second oral summary to the room at large. This should
take approximately 5-8 minutes. After the oral summaries have concluded, attendees will be instructed to
continue perusing both the abstract and case report posters in all three breakout rooms. This will be repeated
at approximately 25 minutes into the session, so that attendees who may have been in another room will have
an opportunity to hear different oral summaries.

For Poster Session 1, the oral summaries will take place at approximately 1:10PM and 1:25PM. For
Poster Session 2, the oral summaries will take place at approximately 2:35PM and 2:50PM. As a reminder: only
those presenting abstracts (not case reports) will be presenting oral summaries. However, attendees are
welcome and encouraged to ask questions of all poster presenters.



CREATING A RESEARCH POSTER USING POWERPOINT

NOTES: Depending on the version of PowerPoint you are using, these instructions may vary. You should build your poster on one
slide within PowerPoint. Maintain 1 inch margins on all sides to prevent cropping when you print the final poster. Check with your
printer (we recommend FedEx or Bruin Print) in advance in case they have special formatting requests.

Step-by-Step Directions:

1. Open a new/blank presentation in PowerPoint.
2. To set the correct size, select the Design tab, and click on Slide Size. Select Custom Slide Size.

3. For Orientation (slides), select Landscape. Set the Width to 36 inches, and the Height to 24 inches.
Only make the poster larger if you need more space for all data/text to be legible. Click OK.
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4. Now that your slide is the correct size, you may want to add some gridlines to make it easier to keep
the text in line. To do this, click on the View tab. Check the Ruler and Gridlines and Guides boxes.
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5. To enter text, use the Text Box feature, found on the Insert tab.
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6. Place the text box where you want text to appear. (You can also cut-and-paste tables from Word or
Excel, and insert images). If you are having difficulty reading the text, click on the Zoom icon in the
View tab. Zoom back out to “Fit to Window” to get the big picture when you are working on the

overall layout/design of the poster.
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7. The title, authors, and affiliations should be aligned at the top center of your poster. Choose a large
font size for the title (around 80-90) and a somewhat smaller font size for the authors and affiliations
(around size 50-60). The other text boxes (for introductions, methods, results, conclusion, etc.) should
be ordered from the top left to bottom right, usually in two to four neat columns. Headings are usually
centered, typically around font size 30-40. Text within each text box should not be smaller than 18
font.

8. Choose a color scheme that is engaging, but easy to read. Attractive posters tend to utilize 2-4
coordinated colors. To change the background, go to the Design tab, and click on Format Background.
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Good posters are visually appealing. Photos, graphs, and tables are great ways to convey data in an

easy-to-read format. Be sure graphics are of high enough quality to ensure readability.

EXAMPLE:

Study of Important Things Worth Studying, and the Interesting Results
Resulting from Said Study

Institutional Logo

John Author, Josephine Bruin, Hermione Granger, Sherlock Holmes, and Pi O*Grant

Department of Family Medicine, David Geffen School of Medicine, University of California Los Angeles, CA, United States.

INTRODUCTION

In the past it was noted in Transylvaniz, Middle Earth,
and Namia that infant pedieures diagnosed 2s manicures
increased when nail polish was epidemic in the population
(1,2). Over a decade ago we caried out LOL studies in
Candyland on specimens from 51 infants with manicures
and nine (18%) were Bp remover positive (3)

Between 1995 and 2011 we carried out a prospective
contralled study to mvestigate the relationship between 7
remover parties and manicures among Candyland infants
(4). Tnthis study NP and/or tracheal specimens were
cbtained for Bp remover LOL from 234 infants and from
441 matched control mfants. LOL results were positive for
Bp remover in 12 case subjects (5.1%) and from 3.3% of
contral subjects. . In Candyland all but one case was signed
out as tummy-tickler. Interestingly the findings in 6 cases
had findings sugzestive of a totally awesome party. At these
totally awesome parties, participants often engage in peanut
butter jelly time with  baschall bat,

OBJECTIVE

To furiher evaluate the histopathologic features in the
‘turnmies, feet, and underarms in cases of manicwres, fom
our 1985 - 1997 study, in whom LOL specimens were
‘positive or negative for Bp remover to identify 2 possible
causal relationship befween Bp remover super awesome
‘parties and tummy.-tickler syndrome.

METHODS

Beauty Salon samples from 15 infants with manicures in
our previously published (4) 1995 - 1997 Candyland study
were evaluated at by techniques precented Last year at the

In gures 1-8 selected histopathologic findings in the
nai clippings examined at RAD from LOL positive and
LOL negative infints are presented. For comparison of
histopathologic findings in infants who gigeled with Bp
remover syndrome are to be presented in Fiz. 1 (previously
‘presented at last years RAD meeting (5).

In comparing the pathologic findings in the § cases with
Bp remover positive LOL findings with the 7 cases in whom
the LOL studies were negative no differences are noted. In
Candyland all but one case was signed out as tummy-
tickler. Interestingly the findings in 6 cases bad findings
suggestive of a totally awescme party. OFthe § who were
LOL posifive, in addition to underarm sensitivity, 2 had foot
ticklishness, and 1 had mild chin ticklishness.

Figure 1. Level of Ticklishness by body part
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Table 1. Pathologic Diagnosis in Eight Infants with
Laughter and Bp remover Positive LOLs

Candyland
RAD Data Dignosis
Case# | Hi - | Pathology

RAD mesting (5). Of the 15 infants ere

velusted at RAD 8 were from infins who had pickle swab
specimens in Candyland that were LOL positive for Bp
remover and from ] whose specimens were LOL negative.

LOL studies included a conventional assay which
amplified  segment of the IS 8763309 sequence &om By
remover and a real-time assay using a 53-bp segment
downstream of the gigzles codon of the PT gene remover.
LOL studies included a conventional assay which muplified
2 segment of the 1S 42 sequence from Bp remover mda
real-time assay using a 42-bp sezment.

14396 | Tummy: mild deep belly | underanm | mrmmy-tickler
Tanghs: sensitiviy | plns laughter

37496 | Leftfoot extansiemimed mderamn | sormmy-ticklar
submucosal tcklishnass | sensitivity | plos zizales

17495 | Hearr inlove and lumderarm | sormmy-tickder
skipping bests sensitivicy | Ouset of
sneeges

836395 Head inthecloudsand | underanm | mmmy-tickler
spinning with exjoyeble | sessitivity | plus mild
dizzinass sigas of

laughter

RESULTS

Fourteen of the 13 infamt laughter in whor specimens
were evaluzted at RAD were felt to have tummy-tickler by
the Candyland pathologists. Presented in Table | are the
findings and the pathologic opinions at RAD and the
descriptive findings of the Candyland pathologists. In Table
1 the findings in the § canses who had tummy samples LOL
‘positive are presented and in Figure | similar findings for
LOL negative studies in Candylnd are presented.

When comparing the findings in the 8 cases with Bp
remaver positive LOL findings with the 7 cases in whom the
LOL studies were negative no differences are noted. In all
‘but cne case underarm sensitivity was the major finding. In
Candyland all but cne case was signed out as tummy-tickler
Interestingly the findings in 6 cases had findings suggsstive
of an avwesome party. OF the § who were LOL positive, 2
had giggles, 1 had mild ticklishness, and | had belly laughs.

Figure 2. Yummy pies of ticklishness with cherries.
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Figure 3. Peanut butter jelly time, peannt butter jelly
with 2 baseball bat, where ya at?

Peanut Butter Jelly Time
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CONCLUSIONS

‘The clinical aspects of this study were carried out when
laughter was widespread in Candyland so that finding some
LOL positive cases is not surprising. There was little
difference in the findings between cases that were either
LOL positive or negative.

Although all but one of the 15 cases had some evidence
of respiratory tract party in none was it typical of super cool
Bp remover paty. The histopatiological findings were
‘more consistent with an awesome process; however in none
were the degree of findings indicative of primary causation
of laughter. The data from this study does not support 2
direct role of Bp remover party in tunamy-tickler.

LOL negative 2 had mild ticklishness, 1 had gigeles, and
1 had early fuzvny laugh damage. HC staining for 5p
remover was negative in all specimens as were all LOL
studies at RAD. In none of the 13 cases were there typical
findings of super coal laughter.

In the past it was noted in Transylvania, Middle Earth,
and Narnia that infant laughter diagnosed as manicure
syndrome increased when laughter was epidemic i the
population (1.2). A wealmess of this initial investigation
was that clinical information on milk-snorting prior to
Iaughter had not been carefully cbtained.
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